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VERTICAL MAPPER (MAPINFO PROFESSIONAL)

A szoftver fobb ismérvei

A Mapinfo felépitése

A Mapinfo az egyik legkonnyebben kezelhetd Windows 9x-en miikodd térinfor-
matikai program. Els@sorban vektoros elemek — pont, vonal, feliilet — feldolgozasara
szolgal, de bizonyos korlatok kozott raszteres adatokat is képes kezelni (csak megje-
lenitési funkciok). Az alapvetd allomany tipus a workspace, ami tobb térképi rétegbdl
¢épiil fel. Minden egyes réteghez egy 6nalld TAB f4jl tartozik. Ez az allomany tarolja az
adott rétegen levo elemekre és a hozzajuk kapcsolt egyéb adatokra vonatkozé informa-
ciokat. Egy workspace tartalmazhat térképeket, tablazatokat, grafikonokat, prezenta-
cidkat.

A Vertical Mapper

A Vertical Mapper fontos tulajdonsagokkal egésziti ki a Mapinfot. A meglévd
pontszerli, vonalas és feliileti elemtipusok — melyek diszkrét elemek megjelenitésére
alkalmasak — mellé bevezeti a grid-et, ami az el6z6 hdrommal szemben nem vektoros,
hanem raszteres (minden raszterponthoz egy-egy érték tartozik). Igy lehetdvé valik a
feliiletre folytonosan jellemzd adatok (kontinuumok) — pl. a magassdg — 3D-s megje-
lenitése, valamint az ezekkel az adatokkal torténd szamitasok és elemzések készitése.

A Vertical Mapper 2.5, a 32 bites 4.x-es vagy ennél nagyobb verzidszamu
Mapinfoval hasznalhat6. Telepités utdni mérete kb. 27 megabyte (ez hét megabyte
példafijlt tartalmaz). A program egy bedgyazott MapBasic alkalmazas, mely a
Mapinfoval egyiitt automatikusan indul. A Mapinfon beliil 6nallé meniirészt és gomb-
sort kap. A 3D-s megjelenitést és a grid importot két 6nalld programocska végzi, melyek
a Mapinfo elinditasa nélkiil is futtathatok.

A szoftver funkcioi

Grid fajl készitése

A VM grid tipusu feliiletmodellekre épiil. Ezek elkészitésére, a feladatnak
megfelelden tobb lehetdség is kindlkozik. A grid két részbdl épiil fel: magabol a grid
allomanybol (GRD, GRC) €és egy Mapinfo tab szovegfajlbol. Ez utobbi teszi lehetové a
Mapinfo szamara a grid beolvasasat. A program megkiilonbozteti a numerikus és az
osztaly tipusu gridet. Az egyiknél szamok, a masiknal osztalyok (szoveges tipusok)
kapcsolodnak a cellakhoz. A grid eldallitdsanak tobb modja van:
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Numerikus grid készitése interpolaciéval » Az intrpolalas alapja egy olyan TAB fijl,
mely tartalmazza az interpolalas alapjaul szolgéld X, v, z koordinata harmasokat. A
metddusok csak a pont tipusu elemeket tudjak feldolgozni. Itt 6t lehetdség koziil lehet

Create Grid >

valasztani:
& Select Interpolation Method [ ]
> THL
5 L Py
LA _-'P‘.

Inverse Distance
Weighting

Triangulation with
Smaothing

Rectangular (Bilinear)
Interpolation

Matural

Neighbour
= Simple Kriging
) Ldianced

Cancal |

Héromszogelés simitassal (7Triangulation with Smoothing)

Ezt a modszert els6sorban domborzatmodellek készitésénél lehet jol hasznalni.
Elso 1épésben — a koordinatak beolvasdsa utan — egy haromszogmodell késziil
(ami Onalldan is elmenthetd). A TIN elkészitéséhez meg kell adni a késziild
haromszogek maximalis oldalhosszat és egy tavolsagi értéket, amin belil a
kornyez6 pontokat egyetlen ponttd vonja Ossze. A kovetkezd 1épésben, az
elkésziilt TIN-re illesztjiik a gridet egy 6todrendii polinom vagy egy egyszerl
linedris egyenlet segitségével. Itt kell beallitani a cellaméretet, valamint az
egyenlethez tartozo sulyozasi faktorokat.

£ TIN Interpolation

L, i s

ath Order
Solution

Linear
Salution

- Parameters
Cell Size: 50.0000
S Dimensions: 384 x 381
Wely l—
Factor: 20000
File Size 285k
Exponent: 1.0000
™ Create Miffrom TIN
Filename
|C:\c0p\l\GergD\OK\mapinfD\aIap\SDLtab Browse

<<gack| Finish | Ccancal |

Help Extents

Tavolsag reciprokaval valoé stlyozasos modszer (Inverse Distance Weighting)
Az IDW algoritmust erdsen valtozékony adathalmaz esetén hasznalhatjuk (pl. ha
pontszeri mérésekbdl akarunk az egész teriiletre egy atlagolt kontinuumot
kiszamitani).

Természetes szomszéd modszere (Natural Neighbour Interpolation)

Ennél a tipusnal minden pont koré egy sokszdget szamol a program, majd ennek
tertiletével sulyozva interpoldlja az 0j pontokat, amik koré ujabb sokszoget
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szerkeszt. Hivjdk még a moddszert ,teriilet lopd”-nak vagy ,,teriilet sulyozds-
nak”.

Négyszoges interpolacid (Rectangular Interpolation)

A leggyakrabban strti, szabalyos elrendezésti adatokra alkalmazzak (pl. vala-
milyen szoftver altal generalt ponthalozat). Az igy késziilt feliilet mentes lesz
mind a tal-, mind az alullovésektol.

Krigelés (Kriging)

Krige, dél-afrikai professzorrol elnevezett modszer igen hasonl6d az IDW-hez. A
kiilonbség csupan annyi, hogy a sulyozott atlag kiszdmitasanal a tavolsag mel-
lett a referenciapontok iranyultsaga is beleszdmit az eredménybe.

Numerikus grid készitése felilletmodellekbdl * A program mar a vonalas elemeket is
figyelembe veheti a grid készitésekor, ami itt is TAB allomanybol késziil. Ennek a mod-
szernek két tipusat kinalja fel a program:

& Select Modelling Method

Trade Area Analysis Location Profiler
(HUIt Madel)

Patronage
Prabability
far one Site

Maximum
Patronage
Probability
Using All
Sites

Mext == Cancel

Kereskedelmi teriiletelemzés (Trade Area Analysis ,, Huff Model”)

Ezt a szamitasi modszert kifejezetten piackutatasra fejlesztették. Eldonthetjiik,
hogy egyetlen objektum (pl. bevasarlokdzpont), vagy az Osszes szemszogébol
elemezziik az adatokat.

Elhelyezkedést abrazold modell (Location Profiler Model)

A pontok tavolsagat szamolja és atlagolja a teriilet barmely pontszerli, vagy
vonalas elemétdl. A grid minden egyes celldjahoz tartozo érték, a kornyezd pon-
toknak, a vizsgalt objektumtol valé atlagos tavolsagéaval lesz egyenld, a vizsgalt
teriileten beldil.

Grid készitése Mapinfo feliiletekbdl ¢ Feliiletekbdl allo TAB fajlbol készithetiink gridet,
meghatarozva a tabldzatnak azt az oszlopat, melynek elemeit a grid cellak értékeinek
szanjuk. Minden egyes feliiletet adott méretti cellakkal fed le, és értékiil a kivalasztott
oszlopnak, a feliilethez tartozé elemét adja. Ha az oszlop szdveget tartalmaz, akkor egy
GRC, ha szadmokat, akkor egy GRD allomany keletkezik. Tulajdonképpen a vektoros
allomanyt raszteressé alakitjuk.

Grid allomanyok importaldsa - A program a kdvetkezé formatumok automatikus felis-
merésére, importjara és konvertalasara képes:

Vertical
Mapper >
Create Grid >
Modeling

Vertical
Mapper >
Create Grid >
Region to Grid

Vertical
Mapper >
Create Grid >
Import Grid
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asci Grid

ascr Classified Grid

CRC-500

DTED

Geological Survey of Canada
Geosoft®

MONA

UK Ordnance Survey Grid
USGS DEM.

sDTS — Spatial Data Transfer Standard Grid
MIG Grid

Mapinfo allomanyok pontra bontasa - A vonalakat és poligonokat is tartalmaz6 TAB
allomanyokbol készit egy kizarolag pontokat tartalmazo allomanyt ugy, hogy a vonala-
kat altalunk beallitott stirliséggel pontokra bontja. Ezt aztdn felhasznalhatjuk grid
készitésre, a fent emlitett modszerek egyikével. Ennek a funkcidonak az alkalmazasaval
készithetlink mar meglévd szintvonalak alapjan domborzatmodellt.

Gridek elemzéese és mas miiveletek

A grid fajlokban rejld igazi lehetdség az, hogy egyébként nagyon bonyolult feliileti
elemzéseket tesznek lehetéveé (pl. egy teriilet tobb éves homérsékletének atlaga, ha a
mérések eltérd helyen torténtek, vagy egy terep mely részei lathatok egy pontbdl stb.).
A kovetkezOkben ismertetem a Vertical Mapper ilyen irdnyu képességeit.

Matematikai miiveletek gridekkel « Egy ,.Scientific Calculator” jellegli feliilet all a
rendelkezésiinkre, hogy a felsorolt gridekkel (akar egymassal is) kiilonb6z6 matematikai
miiveleteket hajtsunk végre. Lehetdség van valtozok deklaralaséara is. Az egyenleteket
(hossza: maximum 256 karakter), a kés6bbi Gijrahasznositas érdekében elmenthetjiik. Az
eredmény egy jabb grid fajlként jelenik meg.

%]

& Gnd Calculator

Gridialue | Type | Alias Name |
ath.grd GRD Grid1

lin.grd GRD Grid2 Modify
rectgrd GRD Grid3
GridMath_ResultZ.ard GRD Grid4 Delete

s o[ o | s
4| 5] 8| - || Pew| sat|| Tan | cos
| e m n | Den | Mey | s |
Ll_lﬂl ;l Logwl Radl : |C\ear|

Expression:
|Gridticrias

ew:

il

Help | Load | Save | Ok Cancel

Vertical
Mapper >
Create Grid >
Poly2Point

Grid Manager >
Analysis

Grid Manager >
Analysis >
Grid Calculator
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Levalogatas gridekbél ¢ Levalogathatjuk egy grid bizonyos cellait ugy, hogy a tobbi

gridet sziiroként hasznaljuk. Az ablakos lekérdezo feliilet tulajdonképpen egy nagyon

s o

leegyszertsitett SQL. Akarhany sziir6t megadhatunk, kozottik kétféle — And és Or —
logikai kapocs allhat zarojelekkel is kombindlva. A sziirésnél megadjuk a sziirének
hasznalt grid nevét és egy koztes relacios jellel a sziirési értéket. A képlet helyességét
ellendrizhetjiik, majd tovabblépve beallithatjuk az eredmény grid tulajdonsagait: nevét
¢és formatumat (numerikus vagy osztaly alaptl) valamint, hogy a sziirén atjutott (true)
illetve fennakadt (false) cellaknak milyen — fix, vagy valamelyik gridhez tartozd —
értékeket adjon.

4 Enter Grid Condions B
Output Format
Grid Name [Type | New ’7(-‘ GRD (Values) ¢ GRC (Classes) |
Ath.grd GRD
Sth_Aspectgrd GRD Edit When TRUE When FALSE:
ath_Slope.grd GRD i Use ValuelClass: i+ Usge ValueiClass:
5th_Viewshed.are GRC Insert 10000 0.0000
— — | Rermove & Getvalue From: " Getvalue Fram:
ere ul r
Ath_Aspect.ard == 1350000 AND Clear Ism'gm = Ism'grd -
ath_Aspect.grd == 235.0000 AND " Use MULL Yalue i Use NULL Value
Sth_Slope.grd = 20,0000 AND [ )
sth.grd = 5000000 AND
5th.grd > 300.0000 STy Filename: [C:icopy\OkimaninfolgridinfolGridgelectResults.tab Browse |
Help | Extents | verify | Mest == | Ccancel | Help | Extents << Back | Finish | Cancel |

Meredekség és kitettség vizsgalat - A két feladatot — nem tudni miért — csak egyszerre
lehet megoldani. A fajlneveken kiviil, a meredekségnél a mértékegységet allithatjuk
(szazalék vagy fok), a kitettségnél az északi iranyt definidlhatjuk (valos észak vagy a
szelvény Y tengelye). Eredménytil két numerikus grid f4jlt kapunk.

Metszetkészités - Egy kijelolt (sokszog)vonal mentén metszetet készit az 0sszes meg-
nyitott gridekre vonatkozdéan. Az eredményt egy utdlag, megjelenésében mddosithato
grafikonon mutatja meg.

Vektoros sziirés * A vonalas elemtipussal val6 szlirésen tal, a maradék két elemfajtaval
is szlrhetjiik a gridet. Az els6nél a pontokat tartalmaz6 TAB fajl tdblazatahoz, egy 4j
oszlopban hozzaflizi a pontok alatti cellak értékeit. Feliileti elemek esetén allitani lehet,
hogy a feliilet ald esd cellak értékeibol milyen matematikai formula (pl. minimum,
maximum, atlag stb.) alapjan allitsa el6 azt az egy értéket, amit a tdblazatban az elemhez
kapcsol. Mindkét miiveletnél a teriiletre esd, 6sszes megnyitott gridet szamitasba veszi.

Pont-pont ésszelatas vizsgalata - Elsésorban domborzatmodellek esetén van értelme a
vizsgalatnak, amit a program is csak akkor végez el, ha a z érték méter vagy lab (feet)
mértékegységii. A vizsgalni kivant két pontot, egy szerkeszthetd rétegen 6sszekdtjiik egy
egyenessel. A vonal hiizdsédnak irdnya hatdrozza meg, hogy honnan hova néziink. A
vonalat kijeldlve és a fenti meniipontot kivalasztva megjelenik a bedllito ablak.
Allithatjuk (korrigalhatjuk) a két pont Xy koordinatait, mindkét pontban a felszin feletti
magassagot, hogy szdmoljon-e a Fold gorbiiletével, és hogy hadny pontban végezze el a
szakaszon a vizsgalatot. Ezeken kiviil kérhetjiik, hogy az eredményt — a metszetéhez
hasonlé grafikon mellett — jelenitse meg a térképen és/vagy mentse el tablazat for-

Grid Manager >
Analysis >
Grid Query

Grid Manager >
Analysis >
Create Slope &
Aspect

Grid Manager >
Analysis >
Cross Section

Grid Manager >
Analysis >
Point
Inspection,
Region
Inspection

Grid Manager >
Analysis >
Point to Point
Visibility
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majaban is. A program nem csak az Osszelatast vizsgalja, hanem negativ eredmény
esetén megmondja, hogy mennyivel kéne egyik, vagy masik pontot megmagasitani.

& Point to Point Visibility

Wiewing Parameter

Looking Fram M |4 342497 3077 ¥ |5 289 501.6205
Height Above Surface: |2.0000 (Tower Heighty

Looking To: R |4 344 706.7248 ¥ |5 295 753.0040
Height Above Surface: [0.0000 {Receiver Heighty

Earth Curvature Model: INUrmaI Earth Currature j
Number of Samples:  [500

¥ Eloton Map i

Help EunaDViewer| Salve | Cinse |

Lathatésag vizsgalata  Ezt a miiveletet is csak magassagi értékeket tartalmazo griden
lehet elvégezni. Itt csak a kiindulési pontot kell meghatarozni, és a program megjeldli a
lathato részeket. Az allitasi lehetdségek a kovetkezOk: egyszerii vagy komplex szdmitast
kériink-e (lathato-e? igen/nem vagy tobb fokozat megkiilonboztetése), nézdpont
koordinatai, a nézépont és a célteriilet(ek) magassadga (mindkett6 a felszinhez adodik), a
latokor sugaranak hossza valamint, hogy szamoljon-e a Fold gorbiiletével. Az egyszerti
szamitds egy GRC, a komplex egy GRD f3jlt eredményez.

& Viewshed

Viewshed Parametet
& Simple Calculation (0 - notwisible, 1 = Visible)
 Complex Calculation ¢ +- height to make JUST wisible)

Looking From: X |4 344 147 4845 ¥ |5 291 599.7721
View Point Height; 1.0000 {Tower Heighf)
Viewshed Offset 1.0000 {(Receiver Height)
Viewing Radius: 18 500.0000 {meters | feef)

¥ Correct for Earth Curvature

Description: |Prédikélﬁszék

Filenarne: |C:\c0mﬂOK\mapinfo\grid\Etthiewshed.tab Browse |

Help Ok cancel

Izovonalak szerkesztése gridbél  Tulajdonképpen a raszteres grid alloméany vektori-
zalasardl van szd. Osztaly tipust gridek esetén egyszerii a dolog, mert csak korbe kell
keriteni az eltérd tipusu csoportokat. Numerikus grid esetén mi adhatjuk meg az izovo-
nalak értékeit melyeket interpolalassal hoz 1étre a program. Eredményiil simitott és

automatikusan ,,lyuk- és sziget” mentesitett izovonalakat tartalmazé TAB allomanyt
kapunk.

& Contour
= Value <Value Colour
)
00,0000 2000000 Paylines | | Regions
200.0000 350.0000 i 660031
350.0000 500.0000 7 Max 7640064

500.0000 700.0000 - Minimum: [0.0000
700.0000 1000.0000 - Maximum: |1 000.0000
interval:  [200.0000

nmeer: 5 2]
Colour Gradient
100.0000 [ I™ Creats Legend
ooon Delete % Creats Cantours
Eilename: [CAcopy:0Kmapiogridisn_Trim_contour b Browse

Help ok cancel

Grid Manager >
Analysis >
Viewshed
Analysis

Grid Manager >
Contour
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A vonalak lehetnek nyitottak (Polylines, pl. szintvonal), vagy zartak (Regions, pl.
hipszometria). Megadhatjuk a minimalis és maximalis hatarértéket, az intervallumot
vagy akar az izovonalak darabszamat. A vonalak értékein tal, allithatjuk szintiket,
kitoltéstiket (ha zart), vastagsagukat €s tipusukat. Itt is van lehetdség arra, hogy a bealli-
tott értékeket elmentsiik, majd Gjra felhasznaljuk.

Az izovonalakkal egyszerre, de akar kiilon is, elkészithetjiik a hozza tartozoé jel-
magyarazatot.

Informacio a gridrol

Adatok a grid fajlrél « A gomb lenyomasaval kibéviil a Grid Manager ablaka.
Megtudhatjuk a grid fajl altalanos tulajdonsagait, a magassagi és arnyékolasi értékeket,
a gridre vonatkozé meta adatokat, a szinkulcsot és a grid hisztogramjat. A hisztogram és
a magassagi adatok csak numerikus gridekre vonatkoznak.

Adatok a grid elemeirdl « Barmelyik nyitott Map Window-ba kattintva, megjelenik egy
informaciods ablak. Megadja az Xy koordinatakat, valamint az osszes grid fajlnak (ame-
lyeknek be van kapcsolva az Info funkcidja a Grid Manager-ben) az ehhez a
koordinatdhoz tartozd értékét. Lehetdség van, az igy szerzett adatok folyamatos
rogzitésére (Capture Data).

Egy meglévo feliileti elem teriiletére es6é grid darabrdl is informalddhatunk.

2D-s megjelenités

A pontokhoz kotott értékeket vagy tipusokat tartalmazo gridet valahogy meg kell
jeleniteni. Mivel raszteres alloméanyrol van szd logikus, hogy a kiilonbozd értékeket
szinekkel abrazoljuk.

A GRD fajloknal megjelend Grid Colour Tool ablakban, a kiilonbozd szineket és a
hozzajuk tartozé értékhatarokat allithatjuk be. A bedllitott szin-érték kombinaciot aztan
elmenthetjiik és barmikor Gjra behivhatjuk. Itt allithatjuk be, hogy akarunk-e summert a
kétdimenzids, mapinfos megjelenitéskor. Valtoztathatjuk az irany- és magassagi szoget,
a kontrasztot és a fényességet.

Data Histogram
Sth.grd

100.00 22

[]
= 200.00 5
(] 350,00 718
] 500,00 921
[ ] 70000 937
M'WM’W-\M
500
s -

A —f—f——~

¥ &dd Relief Shading FipColows | Legend.. | Load Profie.. | Save Profie.. |

Grid Manager >
Info

Grid Info Tool

Region Info Tool

Grid Manager >
Colour
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A Grc allomanyok esetén a Dictionary Editor jelenik meg, ahol kivalaszthatjuk a
megjeleniteni kivant elemtipusokat €s a hozzajuk tartoz6 szineket.

Lehetdségiink van egy kiilon TAB alloméanyban szerkesztett jelmagyarazatot 1étre-
hozni, az ezekbdl az ablakbdl indithatd Legend Generator-ral. A generator szamos
paraméterezési lehetdséget kinal, melyekre nem térek ki részletesebben.

3D-s megjelenités

A hidromdimenzios megjelenitésért a GridView nevll — akdr 6nalldan is futtathatd —  Grid Manager >

program a felelds. A program ¢és a hozza kapcsolodd funkcidk, a Grid Manager-bol
érhetdk el egy legordiilé menii révén, de csak numerikus gridek esetén.

& 5th - GridView

File View Help

Scene Properties

Viewingl Surface and Lighting  5th I

Preview Resolution
= Draw
Underside ~fF——
a5E ZValue:
W Showbee | Exeggerston[i i =]

r
Thickness W Momalized Mode

% True Scale Mods
i Clipping

®o Min |4aanann Max [4350400 Hesetl
Yo M M |
in [5ze3250. 2% [5302600. | Reset Loper [ Grid Height

H&i5th 0.00

= Drap:
Trareparency

¥ | Hide fhen e il sl

Ok I Cancel Grid Estents Unload

3D View

Sikrajzi elemeknek a feliiletre illesztése * Az elsé meniipont hasznéalataval barmilyen, Grid Manager >

a Mapinfoban megjelend tartalmat rafeszithetiink a 3D-s modellre. A kivant grafikékat
a grid fajllal kozos ablakban kell megnyitni, majd az egérrel kivalasztani a drape-elni
kivant nézetet. A drape-elés sordn egy DRP leir6allomanyt valamint egy raszteres képet
kapunk a teriiletr6l, az altalunk beallitott pixelméretben.

Feliiletek 3D-s megjelenitése « A GridView elinduldsa utan a haromdimenzios latvanyt
paraméterezhetjiik ugy, hogy egy preview ablakban végigkdvethetjiik a valtozasokat. Az
allitasi lehetdségeket harom csoportba osztottak:
- Nézet (Viewing)
Itt allithatjuk be a nézépont és a célpont (amit néziink) X, v koordinatait és
magassagat. Lehetdség van arra is, hogy csak az egyik pont koordinatait adjuk
meg fix értékekkel. Ilyenkor a masik pont helyzetét az els6tdl szamitott polaris

3D View >
Make 3D Drape
File
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koordinatakkal adhatjuk meg. Megadhatjuk még a horizontalis 1atoszoget (O-
90°), aminek — a latvany szempontjabol — nagyito-kicsinyitd hatdsa van.
Feliilet és megvilagitas (Surface and Lightning)

Megadhatjuk a sugaras (fokuszalt és diffuz) és szort fények erdsségét szazalék-
ban, valamint a fényforrds magassagi és iranyszogét. Donteniink kell, hogy a
modell racshalds vagy kitoltott legyen-e, simitva legyen-e a feliilet, és mekkora
legyen a késziilo raszteres kép mérete (pixelekben). A feliilet fényességét és
fényvisszaverd képességét is szdzalékban kell megadni. A hattér és az érték
nélkiili tertiletek szinét is mi hatarozhatjuk meg, s6t az eget is szimulalhatjuk a
megfeleld hattérkép betdltésével.

Betoltott gridek és drape-ek (Loaded Grids)

Amennyiben drape f3jlt illesztiink a gridre, akkor csak a drape-pel kapcsolatos
allitasokra van lehet6ség. Ekkor a drape atlatszosagat allithatjuk valamint, hogy
mutassa-¢ a griden esetleg tulnyul6 teriileteket is. A grid esetében szintén sza-
balyozhatjuk az atlatszésagot, ezenkiviil bekapcsolhatjuk, hogy a grid alul-
nézetbol is lathatd legyen. Megadhatjuk még a magassagi torzitds szorzojat és a
tombszelvényalap vastagsagat. Végiil a Clipping koordinatdk megadasaval
elérhetjiik, hogy a gridnek csak a koordinatakkal lehatdrolt része jelenjen meg.
Egy nézeten beliil tetszéleges szamu gridet és drape fajlt jelenithetiink meg
egyszerre. Ezeket a Load illetve az Unload paranccsal tudjuk ki- és bekapcsolni.
A beallitasokat egy kiilon alloményban elmenthet;iik.

A beallitasokat elvégezve egy raszteres képet kapunk. Ha barmin valtoztani
szeretnénk, akkor vissza kell térniink az elébb felsorolt allitasi lehetdségeket
kinalé panelhez, majd a mddositott paraméterekkel, egy uj képet kell general-
tatni. Az eredményt kinyomtathatjuk, vagy bitmap-ként elmenthetjiik.

Egyéb miiveletek gridekkel

Néha sziikség lehet a grid néhany alapvetd tulajdonsaganak a megvaltoztatasara.
Erre szolgalnak a kovetkez6 funkciok.

Grid konverter * Mivel a 2.0-s Vertical Mapper grid f3jlja jelentsen eltér a korabbi
verzioétol, igy ezzel a modszerrel lehet azokat is olvashatova tenni.

Grid export * Exportalni a kdvetkezd formatumokba lehet:
Ascit Point Export (.txt)
DXF Point File
DXF Mesh
DXF Mesh (MicroStation)
VRML (.wrl)
Mapinfo Point Table (.tab)
Windows Bitmap (.bmp & .tab)
Ascit Grid Export (.txt)
TIFF (.tif)

Grid Manager >
Tools

Grid Manager >
Tools >
l.xto 2.0

Grid Manager >
Tools > Export
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Vetiiletvaltas  El0szor az 1j vetiiletet kell kivalasztani. Ha a koordinata transzformacios
hiba (atszamitja a grid bal also és jobb fels6 pontjanak koordinatait az uj vetiiletbe, majd
vissza a régibe) kisebb, mint 0,0000001% akkor végrehajtja a transzformaciot. A transz-
formacid eldtt lehetéség van a celldk méretének megvaltoztatdsara, de csak bizonyos
hatarok kozott.

Atméretezés * A cellaméret atalakitasara szolgaldo modul.

Gridek osszekapcsolasa  Szomszédos, vagy egymason levo gridek 0sszeolvasztasara
lehet hasznalni. Két procedurat épitettek egybe: a Merging-et és a Stamping-et. Az
elsénél egymast kitakard celldk esetén, valamilyen elv alapjan a régi értékekbol
szamitva, az 0j celladkhoz 1j értéket kell rendelni. A mésodiknal csak meg kell hatarozni,
hogy a kozds teriileten melyik korabbi grid cellai legyenek érvényesek. Osztaly tipust
grideknél csak a masodik metddus lehetséges.

Grid trim * Barmilyen eldre kivalasztott poligonnal, kivaghatunk egy darabot a gridbdl,
egy Uj f4jlt hozva létre.

Osszevonasi technikak » Bizonyos esetekben sziikség lehet a feliiletmodell elemeinek
valamilyen csoportositasara. A fenti két metodus ilyen esetekre kinal megoldast.

» lermészetes szomszédsag” elemzés * Bizonyos témakat nem szerencsés kontinuum-
ként dbrazolni. Ez az opci6 lehetdve teszi, hogy a grid elemeibdl diszkrét feliiletet készit-
stink. A program Delaunay haromszogeléssel poligon halozatot szerkeszt a pontok koré.
Ezzel tobbek kozott lehetdveé valik a pontsiiris€ég vizsgalata egy amugy szabalyos racs-
feliileten.

A program hasznélata

Feliiletmodell(ek) készitése

Els6 1épésben, a ddm50.txt-bol készitettem, egy ddm50.tab alloméanyt. A vetiiletet
non-earth (meters)-re allitottam. A munkateriilet méretét — az X, Y min. és az X, Y max.
értekeinek megvaltoztatasaval — megndveltem, mivel a keletkezd grid sarokpontkoordi-
nata-értékei ,,tullogtak™ az alapbedllitds hatarértékein. Ez tobb problémat okozott (pl. a
drape fajlt nem volt képes eldallitani), mieldtt rajottem volna a megoldasra. A gridet
haromféle modszerrel allitottam eld (interpolalassal), a cella méretét mindharom esetben
50 méteresre allitottam. Egy-egy f4jl eldallitdsa kb. 5 percig tartott.

Az els6 két esetben a Triangulation with Smoothing-ot hasznaltam, az egyiknél
sima, a masiknal az 6todfoku fliggvény modszerét hasznaltam a négyzethalonak a TIN-re
vald illesztésekor. Az eredménygridek 100%-osan egyformak lettek, ami annak kdszon-
hetd, hogy a forras allomany is egy 50 méteres szabalyos racshald volt.

Harmadjara a Rectangular interpolation-t probaltam ki. Késébb a Grid Calculator-
ban — ahogy az eldbbi esetben is — az egyik eldz6 griddel elosztottam ezt. Az eredményiil

Grid Manager >
Tools >
Reproject

Grid Manager >
Tools >
Resizer

Grid Manager >
Tools >
Splicer

Grid Manager >
Tools >
Trimmer

Vertical
Mapper >
Data
Aggregation
Vertical
Mapper >
Natural
Neighbour
Analysis
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kapott gridbdl kidertil, hogy csak a pontok elenyész6 szamaban lett mas a magassag, és
ott is mindig 1 mm-en beliil.

Mivel a gridek interpolalassal jottek 1étre, igy a szelvény hatarain tal is keletkeztek
értékek, ezért a Trimmer segitségével, a keret mentén korbevagva az eredeti gridet,
elkészitettem az Sth_trim.grd-t, amit pl. a térképszelvényhez hasznaltam. A késébbiek
soran ezt €s az 5th.grd nevi allomanyt hasznaltam a fenti harombdl.

A tematikak elkésziteserol

Az animaciokat leszamitva — melyek elkészitésére a program nem képes —, minden
tipusra sikeriilt eredményt produkalni. Nehéz a Mapinfoban kiilonvalasztani a két- és
haromdimenzids miiveleteket, mivel el0szor mindent két dimenzidban kell elkésziteni,
majd néhanyukat haromdimenzidssa alakitani. Ezért a csoportositaskor mindent, aminek
az elkészitése inkabb a 2D-s részben volt érdekes, vagy eltérd a tobbitdl, azt ebben a
részben emlitem meg.
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A 2D-s temak feldolgozdsa

Szintvonalrajz ¢ Elkészitéséhez, a Contour-t hasznaltam. A szintvonalak 0,1 pont
vastagok €s barndk, a fészintvonalak 0,2 pont vastagok €s piros sziniiek lettek. Elég
nehézkes volt, hogy a fészintvonalak ezen tulajdonséagait egyesével kellett beallitani. A
Label funkcioval lehetséges a szintvonalak megirasa. Hatranya, hogy nemcsak a f0szint-
vonalakra keriil megiras. Ezenkiviil a vonalak megszakitasa helyett a szintvonalszamot
magabafoglald négyzet csak kitakarja az alatta levo részt, alkalmanként a szomszédos
szintvonalakat is megszakitva.
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Hipszometria ¢ Hipszometriabol végiil kétfélét hasznaltam. Az egyiket a Contour-ral
készitettem. Ezt a térkép ald illesztettem. A masik megoldas menet kdzben adodott. A
grid megjelenitését szabalyozd Colour-ban, az el6z6hoz hasonlo beéllitasokat készitet-
tem, viszont itt folyamatos a szinatmenet, ami bizonyos esetekben esztétikusabb képet
nyujt, féleg az ugyanitt bekapcsolhaté summerrel egyiitt. igy a legtobb tematikénél, ahol
a grid ohatatlanul atlatszik, ezt valasztottam alapnak.

Summer ¢ Kiilon summerkészitd opcioval nincs felruhdzva a program. Az eldbbiekben
leirtak soran allitottam be a summer tulajdonsagait, majd a Grid Manager-ben kikap-
csoltam a szineket a grid mellett és igy csak a summert mutatta. Ezt az allapotot exportal-
tam raszteres képformatumba. A Mapinfo ilyen irdnyl gyenge képességei miatt, inkdbb
drape-eltem az ablakot és az eredményiil kapott drape és bmp f4jlbdl csak az utdbbit tar-
tottam meg. Ezzel a mddszerrel lehetdségem volt a kép szélességét pixelekben megadni,
¢s nemcsak a képernyOn lathato darabot, hanem a teljes szelvényt rogzitette.

Kitettség és meredekség o A Kkitettséget és meredekséget mutaté gridet egyetlen
utasitassal lehet létrehozni. A kategoriahatarok simitdsa érdekében, a Contour segit-
ségével mindkét gridrol elkészitettem a sajat ,,hipszometridjat”.

Pont-pont dsszelatas vizsgalat » A pont-pont lathatosagi vizsgalatnal, a ,,honnan-hova”
szakasz megrajzoldsaval akadtak gondjaim. A csucsokat jelentd haromszogek nem
egyeztek a grid lokalis maximum pontjaival, igy a feladat megoldasahoz elészor pon-
tosan meg kellett hatarozni a csucsok helyét. Otszaz pontban vizsgaltattam meg a koztes
szakaszt. Az eredményt az Osszes lehetséges modon rogzitettem (grafikon, tablazat,
térkép). A térképen piros jeloli a nem-, zold a lathatd részeket, az irdnyt kék nyilak
mutatjak. Valami okbdl a térképen és a grafikonon megjelend eredmény nem egyezik.

Kivancsisagbol egy sokszovonal segitségével elkészitettem a Duna-meder met-
szetét, végig a szelvényen. A vizsgalat ,,gyanus” eredményt hozott. Lehetség van arra,
hogy a Pont-pont vizsgalat eredményét, a 3D Viewer segitségével azonnal 3D-ben meg-
nézziik.

Metszet » A metszet elkészitése volt talan a legegyszeriibb feladat. Az egyetlen apro
gond, hogy a harom garfikont tartalmaz6 abra esetén a meredekségi és kitettségi fok
mérdszamokat abrazolo grafikonokat nem lehetett kiilon koordinatarendszerben feltiin-
tetni.

A 3D-s témak feldolgozdsa

Egyediil a Vertical Mapper — igaz nem valosidejii — 3D-s megjelenitési modszeré-
vel lehetett tetsz6leges kivagatu és felbontast eredményt produkalni.

Alapbedllitasként 2,5-sz0rds magassagi torzitdst hasznaltam, kivéve a nem
madartavlati nézeteknél, ahol nem hasznaltam.

Belathatosag (Viewshed) o A vizsgalatndl az egyszeriibb megoldast — lathato-e?
igen/nem — alkalmaztam. Az eredményiil kapott osztaly alapu gridbdl a Contour-ral
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simitottabb TAB fajlt készitettem, amibdl mar térolhettem a ,,nem” teriileteket, igy azok
nem fedték ki a térkép egyéb részeit. A 3D-s megjelenitéshez a Prédikaloszék csucsjelét
egy rikité folttal helyettesitettem, hogy a madartavlati nézeten is lehessen latni.

Térkép « A térképet onmagaban és hipszometriaval kiegészitve jelenitettem meg 3D-
ben. Az eléirasos ENy-i iranybol (a Gridview-ban 135°) és 45° magassagbol jovo fény
esetén az eredmény til sotét lett, ezért inkabb a szokasostodl eltérd, de szebb képet mutatod
bedllitasokat hasznaltam (a Gridview rendszerében: irdnyszog = 60°, magassagi
sz0g = 45°).

Urfoto és fototérkép » A LANDSAT képet tartalmazé tombszelvényt ugy forgattam el
(45°), hogy a valos irdnyu fény esetén is kellden megvilagitott legyen a terep. A fény
iranya igy 76° lett.

Egyéb » Az egyéb kategoridba soroltam annak a Grid Query lekérdezésnek az ered-
ményét is, amit a magassagi €és a meredekségi griden végeztem. Kértem mutassa meg
azokat a teriileteket, melyek a 300 és a 600 m-es szintvonal kozé esnek, és mere-
dekebbek, mint 15°.

Egyéb funkciok haszndlata

Jelmagyarazat készités « A Colour és a Contour hasznalata esetén is lehetéség van
kiilon jelmagyardzat készitésére. Az egyetlen gond az volt, hogy a jelmagyarazat
készitésekor az elsd értékhez tartozd szinrél megfeledkezik, igy a szinek egy értékkel
lejjebb tolodnak és az utolso érték mellett nem jelenik meg semmi.

Nyomtatas ¢ A Mapinfo beépitett nyomtatasi funkcioi elég mostohak. Elvileg lehetdség
van rd, hogy egy térképbdl tetszéleges méretii (kivagath) részt, tetszéleges méretardny-
ban nyomtassunk. Mivel ezt nem sikeriil megoldanom, inkébb eltekintettem az 1:50 000-
es méretaranytol, és a kitoltdttem a teljes nyomtatasi feliiletet (A4-es papir).

Exportalas * Kiprobaltam még az Export Grid funkciot is, az 5Sth.grd-t minden lehet-
séges formatumban elmentettem. Erdemes megvizsgalni az exportalt Sth.txt és az eredeti
ddm50.txt els6 néhany sorat:

ddm50.txt 5th.ixt

1 4331050.00 5302450.00 245 |4331050.00 5302450.00 244.99650001
2 4331100.00 5302450.00 248 [4331100.00 5302450.00 247.99909317
3 4331150.00 5302450.00 249 [4331150.00 5302450.00 248.99645804
4 4331200.00 5302450.00 254 [4331200.00 5302450.00 253.99378093
5 4331250.00 5302450.00 256 [4331250.00 5302450.00 255.99900924
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Tapasztalatok Osszefoglaldsa

A harom program koziil ez a legkisebb, a leggyorsabb ¢és a legjobban strukturalt.
Kiemelkedden jo helpjénél csak egyetlen kis hidnyossagot tapasztaltam, hogy a nem tual
ritkan el6bukkan6 hibatizenetek értelmérdl (jelentésérdl) egy szot sem fir.

A program soran felbukkand kisebb-nagyobb problémakat valamilyen iton-méodon
mindig sikeriilt megoldani, vagy athidalni. Ez f0ként a mapinfos alloméanyok szoveges
alapu szerkezetének koszonheto.

Kifejezetten €lvezetes volt a VM haszndlata, hiszen az engem érdekld funkciok
egyszerien szabalyozhatdk, €s konnyen elérhetdk voltak, valamint gyors eredményeket
produkaltak. Szerencsére a program soran késziilt allomanyok — mivel mindegyikhez
kapcsolodik egy TAB fajl is — raszteres képként egy ,,csupasz” Mapinfoval is behivhatok,
csak a griddel kapcsolatos beallitasokon nem tudunk valtoztatni. A hdromdimenziés fel-
dolgozas kicsit esetlennek tlinhet, de ez abbdl fakad, hogy a Mapinfo — egyeldre —, csak
kétdimenzids alloméanyokat kezel. igy viszont a 3D-s abrak megjelenitése sokkal jobban
szabalyozhato, mint a masik két szoftvernél. Szerencsés az a megoldas, hogy a 3D-s
megjelenitd, nem csak a Vertical Mapperbdl indithato, hanem 6nélldan is futtathato.



